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II – INTERACTION EN 3D 
En utilisant Blender, vous créez un monde qui existe en quatre dimensions :  
1. Une dimension Gauche-Droite, couramment appelé l'axe X.  
2. Une dimension Avant/Arrière, couramment appelé l'axe Y.  
3. Une dimension Haut/Bas, couramment appelé l'axe Z.  
4. Une dimension Temporelle, à travers des Objets et des matériaux animés et une capture du mouvement dans des cellos. 
 

Le problème est que vous avez un écran d'ordinateur bi-dimensionnel devant vous ! Votre souris ne peut se déplacer que selon 
les dimensions Gauche-Droite et en Haut-Bas. Vous ne pouvez pas revenir en arrière dans le temps, et vous ne pouvez pas, 
littéralement, entrer dans l'écran et y déplacer les choses où vous le voulez.  
A la place, vous devez dire à Blender de le faire pour vous. Ce chapitre vous indique comment naviguer dans votre monde 
virtuel en utilisant l'interface particulière de Blender.  
 

2.1. Navigation dans l'Espace 3D  
Blender vous permet de travailler dans un espace tri-dimensionnel, mais nos moniteurs sont bi-dimensionnels. Pour travailler 
en 3 dimensions, vous devez être capable de modifier votre propre point de vue ainsi que votre orientation dans la Scène. Ceci 
est possible dans toutes les Vues 3D (Viewports 3D) et quel que soit le mode.  
Même si nous ne traitons que de la Fenêtre Vue 3D, la plupart des autres fenêtres utilisent une série de fonctions équivalente. 
Par exemple il est possible de déplacer une Fenêtre de Boutons et ses panneaux ou de zoomer dessus.  
 

2.1.1. Les Options de la Vue 3D (3D View Options)  
La fenêtre de la Vue 3D est l'endroit où vous exécutez la plus grande partie de la modélisation de vos Objets tri-dimensionnel, 
et où vous arrangez ces Objets dans l'espace 3D virtuel. Blender dispose d'un large éventail d'outils et d'options pour vous 
permettre de travailler avec efficacité avec votre souris, votre clavier et votre pavé numérique. Votre moniteur (en deux 
dimensions) est votre porte d'entrée dans l'espace 3D.  
 

2.1.1.1. L'Entête de la Vue 3D (3D Window Header) 
La Vue 3D est composée d'un espace de 
travail et d'un entête. L'entête est placé 
en haut ou en bas de l'espace de travail, 
et peut être caché si vous le désirez. 
L'entête vous propose un menu et le 
mode courant, comme expliqué ci-
dessous.  
 

2.1.1.2. Les Menus de l'Entête 
 

Le menu View  
Ce menu procure des options pour contrôler la façon dont l'espace de travail est visualisé : 

• Space Handler Scripts : Cette commande propose les scripts Space Handler; par défaut, il 
n'y en a aucun. 

• Play Back Animation : Cette commande déroule l'animation à partir du cellos courant.  
• Maximize Window : Cette commande maximise la Vue 3D pour remplir la fenêtre Blender 

entière. Raccourcis : CTRL UPARROW  ou SHIFT SPACE.  
• View All  : Cette commande zoome la Vue 3D pour présenter tous les Objets dans la Scène 

courante.  
• View Selected : Cette commande zoome la Vue 3D pour présenter tous les Objets 

sélectionnés.  
• Set Clipping Border : Cette commande vous permet de définir un bord de découpe pour 

limiter l'affichage de la Vue 3D à une portion de l'espace 3D. Voyez le paragraphe Isolation 
d'un Volume dans une Vue (View Clipping Border) plus loin pour plus d'information.  

• Align View > :  
� Center View to Cursor (C) : Cette commande décale votre vue pour qu'elle soit centrée 

sur le curseur.  
� Center Cursor and View All (SHIFT C) : Cette commande centre votre vue et dézoome 

afin que vous puissiez tout voir dans votre Scène.  
� Align Active Camera to View (CTRL ALT NUMPAD0 ) : Cette commande fait passer 

votre point de vue à travers la Caméra, et centre celle-ci sur le curseur.  
� Align View to Selected (NUMPAD* ) : Cette commande permet de centrer votre vue sur 

l'objet sélectionné (au lieu du curseur).  

 

• View Navigation > : Ce sous-menu contient des commandes pour faire pivoter la vue et faire un panoramique. 
L'utilisation de ces commandes via le menu n'est pas très efficace; toutefois, comme tous les menus Blender, les 
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raccourcis clavier sont affichés à côté des commandes. Le mode Camera Fly déplace votre vue à travers l'espace 3D. 
Utilisez les raccourcis indiqués pour faire orbiter votre vue, ou maintenez enfoncé MMB et déplacez votre souris. Utilisez 
NUMPAD+ /NUMPAD-  pour zoomer, ou utilisez MW . 

• Global View /Local View : La commande Global View montre tous les Objets 3D dans la Scène. La commande Local 
View n'affiche que les Objets sélectionnés. Pour désactiver ceci, utilisez NUMPAD/ . Et si une série d'Objets semble avoir 
mystérieusement disparue de votre Scène, essayez de désactiver l'option Local View.  

• Orthographic , Perspective : Ces commandes modifient la projection de la Vue 3D. Pour plus d'information, voyez le 
paragraphe 2.1.1.4. Projection en Perspective ou Orthonormée (Perspective and Orthographic Projection). En 
général, vous préférerez rester en projection Orthographic .  

• Cameras > : Ce sous-menu liste toutes les Caméras dans la Scène. En sélectionner une en fera la Caméra active. Il y a 
aussi une commande qui transforme l'objet courant (qui n'a pas besoin d'être une caméra) en caméra, de sorte que vous 
pouvez voir à quoi ressemble la Scène depuis ce point de vue.  

• Side, Front , Top : Ces commandes modifient la vue selon les vues du côté gauche (Side), de face (Front ) et de dessus 
(Top) par défaut. Presser SHIFT  tout en sélectionnant ces commandes fait passer à la vue inverse qui lui correspond : vue 
du côté droit (Right Side), vue de derrière (Back) et vue de dessous (Bottom).  

• Camera : Cette commande fait passer la vue par la vue Caméra en cours.  
• User : Cette commande fait basculer sur une vue utilisateur. Dans la plupart des cas, ceci semble ne rien faire, mais si 

vous êtes dans la vue Caméra ou que vous avez activé une projection Orthographic , la vue passera en projection 
Perspective (et quittera la vue Caméra, si c'est possible).  

• Background Image... : Cette commande fait apparaître le panneau flottant 
Background Image, qui vous permet de charger une image à afficher en arrière-plan 
de la Vue 3D Orthographic , ainsi qu'ajuster sa taille et sa position. Ceci est utile si 
vous disposez d'une image (un visage par exemple) à partir duquel vous voulez 
modéliser. Chaque Vue 3D peut avoir sa propre image en arrière-plan. Chaque Vue 
3D peut (ou ne peut pas) utiliser indépendamment l'image d'arrière-plan. Donc, vous 
pouvez donner une image à la vue Top, mais tant que vous ne régler pas les autres 
vues pour utiliser une image, aucune autre vue ne l'utilisera. La vue Side peut en avoir 
une autre, et la vue Front  également. Elles peuvent toutes être la même image si celle-  

ci est une grande composition de toutes les vues que vous voulez comme référence : utilisez simplement les valeurs X 
Offset et Y Offset de chaque vue pour positionner l'image là où vous le voulez. Les images d'arrière-plan peuvent être des 
images fixes, des vidéos (.avi ou séquences d'images) ou même être le rendu d'une autre Scène. 

• View Properties... : Cette commande fait apparaître le panneau flottant View 
Properties, qui vous permet d'activer/désactiver la grille et d'ajuster son échelle, 
d'ajuster le zoom de la Caméra, de basculer des axes spécifiques (X Axis, Y Axis et Z 
Axis), de visualiser la position actuelle du curseur 3D (et éventuellement de la 
modifier), d'ajuster plusieurs réglages pour l'affichage (Outline Selected souligne 
l'Objet sélectionné, All Object Centers montre les centres de tous les Objets et 
Relationship Lines affiche les lignes de liaison), et enfin, vous pouvez verrouiller la 
Vue 3D de sorte qu'elle pointe toujours vers un Objet (ou un Bone) particulier. 

 

• Render Preview... : Cette commande fait apparaître le panneau Render Preview, qui 
affiche une prévisualisation de rendu (relativement) fidèle de ce qu'il recouvre.  

 

Le menu Select  
• Grouped > : Blender possède plusieurs façons de grouper ensemble des items. Ce sous-menu 

contient des commandes pour sélectionner des Objets selon diverses formes de regroupements.  
o Children  : Cette commande sélectionne tous les enfants des Objets sélectionnés (et les 

enfants de leurs enfants, etc.)  
o Immediate Children : Cette commande sélectionne les enfants des objets sélectionnés; 

toutefois à la différence de la commande précédente, elle ne continue pas à sélectionner les 
enfants des enfants, mais simplement la descendance directe du parent.  

o Parent : Cette commande sélectionne les parents des objets sélectionnés.  
o Siblings (Shared Parent) : Cette commande sélectionne tous les Objets qui partagent le parent d'un Objet. Ceci veut 

dire que si vous avez, par exemple, plusieurs Objets Blender composant un Objet physique et qui sont tous enfants 
d'une partie de l'Objet (ou d'un Empty), si vous sélectionnez un Objet Blender qui fait partie de l'Objet physique et 
que vous utilisez cette commande, tous les Objets Blender qui composent cet Objet physique seront sélectionnés.  

o Objects of Same Type : Cette commande sélectionne tous les Objets du même type (Lamp, Mesh, Camera, etc.).  
o Objects on Shared Layers : Cette commande sélectionne tous les Objets qui se trouvent dans les mêmes calques que 

les objets sélectionnés.  
o Objects in Same Group : Cette commande sélectionne tous les Objets des Groupes dans lesquels se trouvent les 

Objets sélectionnés. Ceci peut être utilisé pour le même but que la commande Siblings (Shared Parent) si vous avez 
groupé des parties d'un Objet physique au lieu d'utiliser des parents.  
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o Objects Hooks : Cette commande sélectionne tous les Objets qui agissent en tant que Hooks pour les Objets 
sélectionnés.  

• Linked > : Ce sous-menu contient des commandes qui vous permettent de sélectionner des Objets en se basant sur les 
données (Courbes IPO, Matériaux, Textures, etc.) qu'ils partagent.  

o Object Ipo : Cette commande sélectionne tous les Objets qui partagent les courbes IPO des Objets sélectionnés.  
o ObData : Cette commande sélectionne tous les Objets qui partagent les ObData des Objets sélectionnés.  
o Material  : Cette commande sélectionne tous les Objets qui partagent les Matériaux des Objets sélectionnés.  
o Texture : Cette commande sélectionne tous les Objets qui partagent les Textures des Objets sélectionnés.  

• Select All By Type > : Ce sous-menu contient des commandes qui vous permettent de sélectionner tous les Objets d'un 
certain type (Mesh, Camera, Lamp, etc.).  

• Select All By Layer : Ce sous-menu contient des commandes qui vous permettent de sélectionner tous les Objets dans un 
calque spécifié.  

• Inverse : Cette commande inverse la sélection (sélectionne tous les Objets désélectionnés et désélectionne tous les Objets 
sélectionnés).  

• Select/Deselect All : Cette commande désélectionne la sélection courante, si il en existe une; si rien n'est sélectionné, elle 
sélectionne tout.  

• Border Select : Cette commande vous permet de sélectionner/désélectionner des Objets en utilisant le cadre de sélection 
traditionnel. Elle est équivalente au raccourci B (avec LMB  ou RMB ).  

 

Le menu Object  
Ce menu opère sur des Objets entiers. Beaucoup d'options agissent sur l'Objets actif, en partant d'autres Objets. Vous indiquez 
cela à Blender en cliquant RMB  sur l'Objet de base, puis en cliquant SHIFT RMB  sur l'Objet actif en appelant alors une 
option de ce menu. Au cas où vous voudriez travailler sur plus de deux objets, cliquez simplement sur tous les Objets de base 
d'abord;  le dernier Objet sélectionné sera l'Objet actif. 
• Scripts > : Ce sous-menu propose une liste des scripts Python disponibles pour augmenter 

les capacités de Blender dans la gestion des Objets. Voyez la documentation de chaque 
script pour leur utilisation.  

• Move to Layer : Les Objets peuvent être organisés dans 20 Calques, et seuls quelques 
Calques peuvent être sélectionnés pour l'affichage afin d'éviter l'encombrement. Cette 
commande déplace les Objets sélectionnés vers un Calque. Si ce Calque n'est pas sélectionné 
pour l'affichage, l'Objet disparaît de la vue. Pour visualiser les Objets dans le Calque, cliquez 
sur le bouton de Calque approprié dans l'entête.  

• Convert Object Type : Cette commande a deux fonctions : soit convertir un type d'Objet en 
un autre type d'Objet (par exemple Curve en Mesh), soit d'appliquer définitivement le 
Modificateur qui a été appliqué à l'Objet.  

• Join Objects : Cette commande fusionne plusieurs Objets sélectionnés en un Objet unique.  
• Boolean Operation : Ce sous-menu vous permet de réaliser les opérations Intersect, Union 

et Difference sur l'Objet actif en se basant sur les Objets précédemment sélectionnés. Les 
trois premières options sont destructrices; elles peuvent aussi être rendues temporaires en 
utilisant les options Add Intersect Modifier , Add Union Modifier  et Add Difference 
Modifier .  

• Constraints > : Ce sous-menu vous permet d'ajouter (ou de retirer) diverses Contraintes à un 
Objet en se basant sur un autre Objet précédemment sélectionné.  

• Track > : Ce sous-menu vous permet de faire en sorte que l'Objet actif pointe toujours (ou ne 
pointe plus) vers un autre Objet précédemment sélectionné (mode Tracking ). 

• Group > : Ce sous-menu vous permet de créer (ou d'annuler) des Groupes. C'est une façon 
complètement arbitraire de regrouper des choses ensembles.  

• Parent > : Ce sous-menu permet de désigner l'Objet actif comme étant le parent de un (ou plusieurs) Objet(s) enfant(s) 
préalablement sélectionnés. Quand vous bouger alors le parent, les enfants bougent avec lui. Une option permet d'annuler 
un parentage. 

• Copy Attributes > : Ce sous-menu contient des options qui permettent à l'Objet actif de copier les attributs spécifiques 
(par exemple, Location) d'un autre Objet préalablement sélectionné.  

• Make Local > : Ce sous-menu contient des options pour qu'il soit fait une copie locale d'un Objet d'une autre Scène dans 
la Scène courante.  

• Make Single User > : Un Objet peut partager le même Maillage avec d'autres Objets, donc d'autres utilisateurs. Ce sous-
menu contient des options pour assigner une copie du Maillage multi-utilisateur à l'Objet sélectionné. Vous pouvez alors 
éditer la copie locale de l'Objet sans affecter aucun des autres utilisateurs.  

• Make Links > : Ce sous-menu contient l'option To Scene qui permet de rendre Proxy un Objet vers une autre Scène. Il 
existe dans la Scène courante, mais est également toujours visible dans la Scène reliée. Les options Object Ipo, Mesh 
Data et Materials permettent de faire que l'Objet courant rejoigne la communauté multi-utilisateurs et partage l'item 
correspondant à l'option sélectionnée.  
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• Delete : Cette commande permet d'effacer tous les Objets sélectionnés. Si les Matériaux et Textures des Objets effacés 
étaient Single User et ne sont plus utilisées, ils ne seront pas sauvegardés dans le fichier .blend.  

• Duplicate Linked : Cette commande permet de créer une copie des Objets sélectionnés, mais en liant leurs Maillages en 
multi-utilisateurs, donc si vous en modifiez un, tous les autres de même type seront modifiés.  

• Duplicate : Cette commande permet de créer un duplicata des Objets sélectionnés.  
• Insert Keyframe : Cette commande ouvre le menu Insert Key qui permet d'enregistrer un aspect de l'Objet (Location, 

Rotation, etc. en fonction de l'option choisie) à ce cellos. Ceci correspond à l'insertion d'une image-clé pour les 
animations de base.  

• Snap > : Ce sous-menu contient des commandes qui vous permettent de 'coller' le curseur 3D et la sélection à la grille, ou 
l'un par rapport à l'autre. 
o Selection -> Grid : Cette commande colle la sélection au point de la grille le plus proche.  
o Selection -> Cursor : Cette commande colle la sélection à l'emplacement du curseur 3D.  
o Cursor -> Grid  : Cette commande colle le curseur 3D au point le plus proche de la grille. Ceci est utile si vous 

cliquez manuellement la position du curseur 3D, et qu'il n'atterrit pas exactement où vous le voulez.  
o Cursor -> Selection : Cette commande colle le curseur 3D au centre de l'Objet sélectionné.  
o Selection -> Center : Cette commande colle les items sélectionnés au centre de l'Objet sélectionné. Ceci est très utile 

en mode Edit, car cela vous permet de coller vertices, arêtes ou faces au centre de l'Objet sur lequel vous travaillez. 
• Clear/Apply > : Ce sous-menu contient des commandes qui vous permettent d'appliquer (rendre permanentes) ou 

d'annuler (remettre à zéro) diverses actions activées sur les Objets sélectionnés.  
o Apply Scale/Rotation : Cette commande applique une taille et une rotation standards. Les données de l'Objet (Mesh, 

points de Curve, etc.) sont modifiées de sorte que la taille soit de 1 et que l'Objet ne soit pas pivoté du tout.  
o Apply Deformation : Cette commande applique la déformation réalisée à l'aide d'un Lattice. 
o Make Duplicates Real : Cette commande rend réels les Objets dupliqués (en utilisant  les commandes DupliVerts  ou 

DupliFrames) de sorte que vous pouvez les éditer individuellement. 
o Clear Location : Cette commande remet à zéro (0,0,0) la position des Objets sélectionnés.  
o Clear Rotation : Cette commande remet à zéro la rotation des Objets sélectionnés.  
o Clear Scale : Cette commande remet à zéro la taille des Objets sélectionnés. 
o Clear Origin  : Cette commande remet à zéro l'origine de l'Objet sélectionné avec l’invite OK ? Clear origin. 

• Mirror > : Ce sous-menu contient les options X Local, Y Local et Z Local qui permettent de sélectionner l'axe approprié 
pour réaliser la copie en miroir d'un demi-Objet. 

• Transform > : Ce sous-menu regroupe les principales commandes de transformation (Grab, Scale, Rotate, Warp , etc.). 
o Grab/Move : Cette commande vous permet de grabber librement les Objets sélectionnés.  
o Grab/Move on Axis > : Ce sous-menu contient des commandes qui vous permettent de déplacer un Objet le long 

d'un axe spécifié (X Global, Y Global, Z Global, X Local, Y Local, Z Local).  
o Rotate : Cette commande vous permet de faire pivoter un Objet autour de l'axe Z de la vue dans un sens ou dans 

l'autre.  
o Rotate on Axis : Ce sous-menu contient des commandes qui vous permettent de faire pivoter un Objet autour d'in axe 

spécifique (X Global, Y Global, Z Global, X Local, Y Local, Z Local)  
o Scale : Cette commande permet de retailler les Objets sélectionnés.  
o Scale on Axis : Ce sous-menu contient des commandes qui vous permettent de retailler un Objet par rapport à un axe 

spécifique (X Global, Y Global, Z Global, X Local, Y Local, Z Local).  
o To Sphere : En mode Edit, cette commande transforme l'Objet sélectionné en un Sphère ????? 
o Shear : En mode Edit , cette commande vous permet de donner un aspect 'penché' aux Objets sélectionnés. Ceci 

fonctionne toujours via l'axe horizontal de l'écran. 
o Warp : Cette commande vous permet de gauchir  les vertices sélectionnés en courbes.  Elle peut être utilisée pour 

convertir un plan en un tube, ou même une sphère. Le centre du cercle de courbure est le curseur 3D. La ligne 
médiane du cercle est déterminée par la dimension horizontale des vertices sélectionnés. Vous augmentez (ou 
diminuez) l’angle par défaut (90°), en faisant monter ou descendre la souris. CTRL permet d'utiliser des incréments 
de 5 degrés pour la commande. 

o Push/Pull : Cette commande permet de déplacer l'Objet sélectionné d'avant en arrière sur  une ligne droite qui dépend 
de la position du curseur. 

o Scale to Image Aspect Ratio : Cette commande adapte les dimensions X et Y de l'Objet sélectionné aux dimensions 
de la Texture Image qu'il possède. 

o ObData to Center : Cette commande déplace les données (Mesh, points de Curve, etc.) d'un Objet afin qu'elles 
soient centrées par rapport au centre de l'Objet en cours.  

o Center New : Cette commande permet de déplacer le centre de l'Objet vers le centre des données de l'Objet.  
o Center Cursor : Cette commande permet de déplacer le centre de l'Objet vers la position courante du curseur 3D.   

• Transform Properties : Cette commande (N) fait apparaître le panneau flottant Transform Properties qui vous donne 
des informations clés (position, rotation et taille) sur l'Objet actif et vous permet de modifier ces informations. 
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2.1.1.3. Le Menu des Modes  
Blender dispose de plusieurs modes d'opération :  
• Le mode Object pour travailler sur des Objets entiers.  
• Le mode Edit  vous permet de modifier la forme de l'Objet actif.  
• Le mode Sculpt transforme votre curseur en outil pour modeler l'Objet actif.  
• Le mode Vertex Paint transforme votre curseur en brosse pour peindre l'Objet actif. 
• Le mode Weight Paint transforme votre curseur en brosse pour peindre des pondérations sur l'Objet 

actif. 
• Le mode Texture Paint transforme votre curseur en brosse pour peindre des Textures.  
 

2.1.1.4. Les Modes d'Affichage  
  

Ombrage dans une Vue (View Shading) 
Selon la vitesse de votre ordinateur, la complexité de votre Scène et le type de travail que vous effectuez, vous pouvez 
commuter entre plusieurs modes d'affichage (quel que soit le mode) : 
• Textured (Texturé) (ALT Z ) – Affiche des modèles texturés avec des images UV en éclairage 

OpenGL. Les textures procédurales ne sont pas visibles. 
• Shaded (Ombré) (SHIFT Z ) – Fait une approximation de toutes les textures et de l'éclairage sur 

chaque vertex, et crée une interpolation d'un vertex au suivant. Bien moins précis que l'utilisation du 
moteur de rendu pour les textures, mais plus rapide. Notez que si vous n'avez pas d'éclairage dans 
votre Scène, tout restera noir.  

• Solid (Solide) (Z ou ALT Z ) - Les surfaces sont dessinées sous forme de couleurs solides, avec un 
éclairage OpenGL interne (ne dépendant pas des sources de lumière de la Scène).  

 

• Wireframe (Fil de fer) (Z ou SHIFT Z ) - Les Objets se composent seulement de lignes qui rendent leurs formes 
reconnaissables. C'est le mode d'affichage par défaut.  

• Bounding Box ( Boîte Englobante) - Les Objets ne sont pas du tout dessinés; au lieu de cela, ce mode montre seulement 
les boîtes rectangulaires qui correspondent à la taille et à la forme de chaque Objet. 

 

Le mode d'affichage peut être choisi avec le bouton approprié dans l'en-tête (image ci-dessus) ou avec des raccourcis.  
Vous pouvez également afficher un menu contextuel proposant les différents modes d'affichage avec D.  
 

La Vue Locale (Local View) 
En Vue Locale, seuls les Objets sélectionnés sont affichés, ce qui peut faciliter l'édition dans des Scènes complexes. Quel que 
soit le mode, pour passer en Vue Locale, sélectionnez d'abord les Objets que vous souhaitez isoler (voir le paragraphe 
Sélectionner les Objets) puis utilisez dans la commande de menu View>Local View; pour revenir à la Vue Globale, utilisez 
la commande de menu View>Global View. Le raccourci est NUMPAD/  qui permute entre Vue Globale et Vue Locale. 

 

Isolation d'un Volume dans une Vue (View Clipping Border) 
En assistance dans le processus de travail sur des modèles et des Scènes complexes, vous pouvez modifier le volume de 
découpage (Clipping ) de la vue pour isoler visuellement ce sur quoi vous êtes en train de travailler. 
  
En utilisant cet outil, vous créez un volume de découpage 3D en forme de pyramide. Vous spécifiez la base de la pyramide en 
créant une zone rectangulaire 2D. 
 

L'image ci-contre est un exemple d'utilisation de l'outil Clipping avec un 
cube : 
 

En mode quelconque, commencez par activer l'outil avec ALT B  (étape 
Start)(le menu correspondant est View>Set Clipping Border). Ceci 
génèrera un curseur en forme de croix à tirets. Cliquez avec LMB  et draguez 
une zone rectangulaire (étape Selecting region). Maintenant, une zone est 
définie et le Clipping est appliquée à cette zone dans l'espace 3D. Notez 
qu'une partie du cube est maintenant invisible (ou coupée). Utilisez MMB  
pour faire pivoter la vue et vous verrez que seul ce qui est à l'intérieur de la 
pyramide est visible. Tous les outils Edge/Face fonctionnent toujours 
normalement mais uniquement à l'intérieur du volume de la pyramide. La 
zone grise entourant le volume est le volume même de la pyramide.  
Pour désactiver l'outil Clipping , cliquez ALT B  une seconde fois. Tout 
l'espace 3D redeviendra visible.   
 

2.1.1.5. Le menu Rotation (Rotation Selector)  
Dans un mode quelconque, quand vous faites pivoter (ou retaillez) un Objet (ou une série de vertices/arêtes/faces), vous 
pouvez vouloir décaler le point de pivot dans l'espace 3D. Pour sélectionner le point de rotation (ou point de pivot) par lequel 
passera un axe de rotation, utilisez le bouton Rotation/Scaling de la barre d'entête de la Vue 3D, . Cela affichera le menu 
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Pivot: (image ci-dessous). En utilisant ce menu, vous pouvez faire correspondre le point de pivot avec la position du curseur, 

le centre moyen des Objets sélectionnés, etc. Utilisez le bouton Object Center ( ) pour ne déplacer que les centres des 
Objets sélectionnés.  
 

• Active Object  : Tous les Objets pivotent en se basant sur le centre du dernier Object sélectionné. 
L'axe de rotation passe par l'Objet actif (affiché en rose).   

• Individual Object Centers  : Tous les Objets pivotent ou sont retaillés autour de leurs propres 
points centraux. En mode Edit  : tous les vertices pivotent ou sont retaillés autour du point central 
de l’Object.  

•  3D Cursor : Le curseur 3D est le point central pour la rotation ou le retaillage. Raccourci :  
       ( . ). L'axe de rotation passe par le curseur 3D. 

 

• Median Point : Le point médian de tous les Objets ou vertices est le centre de rotation ou de retaillage. L'axe de rotation 
passe par le point médian de la sélection. Cette différence n'est appropriée qu'en mode Edit , et le point médian est le 
barycentre de tous les vertices.   

• Bounding Box Center : Le point central de la boîte englobante est le centre de rotation ou de retaillage. Raccourci : ( , ). 
L'axe de rotation passe par le centre de la boîte englobante de sélection (si un seul Object est sélectionné, le point utilisé 
est le point central de l'Object, qui n'est pas obligatoirement son centre géométrique). 

 

Pour réaliser des rotations dans Blender, reporter-vous au paragraphe 4.1.3.2. Faire pivoter des Objets (Rotation).   

2.1.1.6. Le menu Manipulateurs (Manipulator Selectors)  
Ces Manipulateurs très pratiques, présents aussi dans d'autres logiciels 3D, vous permettent de faire 
pivoter ou de déplacer des Objets en grabbant leurs poignées et en déplaçant la souris dans l'axe. Chaque 
couleur correspond à un axe. Les boutons correspondent de gauche à droite aux Manipulateurs Move, 
Rotate et Scale. Vous pouvez les utilisez en accord avec une vue Global, Local, etc. en fonction de la 
sélection du menu Orientation , immédiatement à droite. 
En mode Object ou en mode Edit , CTRL SPACE ouvre un menu flottant Manipulator  avec le choix du 
type de Manipulateurs (pressez 2, 3, 4 ou 5 pour modifier le type de Widget) :   
 

Quand vous utilisez les commandes Transform standards (G = Grab, R = Rotation, S = Scale), elles ne 
fonctionneront que parallèlement à la vue courante.  Les Manipulateurs autorisent une représentation 
visuelle des commandes Transform  qui permet d'utiliser facilement ces commandes le long d'un axe 
précis dans n'importe quel mode de la Vue 3D. 
Les Manipulateurs utilisent le type de point de pivot actuellement sélectionné. Par exemple, si vous 
choisissez le Curseur 3D comme point de pivot, le Manipulateur 3D apparaîtra là où est placé le curseur.    
 

Types de Manipulateurs (Manipulator types)  
Il existe un Manipulateur séparé pour chaque commande Transform . Chacun peut être visualisé séparément ou regroupé dans 
une combinaison.  
 

Translate 

 

Rotate 

 

Scale 

 

Combo 

 
 

Les Manipulateurs 3D (ou Widgets) peuvent aussi être activés en utilisant les boutons 
appropriés de l'entête de la Vue 3D :   

• Main  : Active/Désactive les Manipulateurs.  
• Triangle : Permet d'utiliser le Manipulateur Translate (raccourci : CTRL ALT G ). 
• Cercle : Permet d'utiliser le Manipulateur Rotate (raccourci : CTRL ALT R ). 
• Carré : Permet d'utiliser le Manipulateur Scale (raccourci : CTRL ALT S ). 
• Menu : Modifie l'orientation du Manipulateur (Global, Local, Normal ou View). 

 

Lors de l'utilisation de ces boutons, vous pouvez combiner plusieurs types de Manipulateur en SHIFT -cliquant sur ces boutons 
(correspond au Manipulateur Combo). 
 

Autres Commandes pour les Manipulateurs  
• Si vous maintenez enfoncé CTRL , l'action sera exécuté selon certains incréments (Translate/Scale = 1 unité de grille, 

Rotate = 5 degrés).  
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• Si vous maintenez enfoncé SHIFT  quand vous cliquez LMB  sur l'une des poignées du Manipulateur, vous la verrouillez 
(c'est une contrainte planaire) : l'action sera exécutée selon l'axe opposé à celui sur lequel vous avez cliqué; par exemple, 
en SHIFT -cliquant sur l'axe Z bleu, vous pouvez transformer l'Object selon le plan XY  (vous pouvez relâcher SHIFT  une 
fois que vous avez cliqué LMB ). 

• Cliquer LMB  sur le petit cercle (un grand cercle dans le cas du Manipulateur Rotation) ignorera l'axe et le comportement 
sera celui des commandes Transform  standards (G, S, R).  

 

Préférences des Manipulateurs (Manipulator Preferences)  
Les réglages d'un Manipulateur (par exemple, sa taille) se font dans la section View & Controls  de la fenêtre Info  (User 
Preferences) :  
Size : Diamètre du Widget, en unité de 10 pixels.  
Handle : Taille des poignées du Widget, en pourcentage de son rayon (Size/2).  
Hot spot : Taille du point d'application (Hotspot) pour cliquer les poignées du Widget. 

 
Orientation de la Transformation (Transform Orienta tion)  
Les Manipulateurs 3D en mode standard (Normal) sont très utiles, mais dans certaines situations ce n'est pas le cas (par 
exemple, un Manipulateur Scale sur un Object pivoté le long de l'axe de rotation). Heureusement, Blender permet de modifier 
l'orientation des Manipulateurs. En mode Object ou en mode Edit , ALT SPACE ouvre un menu flottant qui vous permet de 
modifier l’orientation de la transformation.  
Le système permet d'ajuster la position du repère d'axes du Manipulateur (repère d'axes 
colorés placés sur l'Object) avec le repère d'axes Global (coin inférieur gauche de la Vue 
3D) : orientation Global et avec le repère d'axes Local (l'Object est un Empty, donc seuls le 
repère d'axes Local de l'Object est visible) : orientation Local. 
L'orientation Normal est l'orientation par défaut.   
 

Global 
Le Manipulateur copiera le repère d'axes Global. 

Local 
Le Manipulateur copiera le repère d'axes Local de l'Object.  

  
 

Normal 
L'axe Z du Manipulateur copiera le vecteur normal de ce qui est 
sélectionné. Ce n'est pas très utile pour un Empty :  

 

 
 

Un meilleur exemple avec la sélection (en mode Edit ) de faces sur un 
Object possédant des normales de faces :  
 

View 
Le Manipulateur copiera les Y→Haut/Bas, X→Gauche/Droite, 
Z→Avant/Arrière  de la Vue 3D. 
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2.1.1.7. Le menu Calques (Layer Selector)  
Les Scènes 3D deviennent souvent exponentiellement plus confuses à mesure que leur complexité augmente. Pour pallier à cet 
inconvénient, les Objets peuvent être groupés dans des "calques", de telle sorte que seuls les calques sélectionnés sont affichés 
en même temps. Les calques 3D sont différents des calques que l'on peut rencontrer dans des applications graphiques en 2D : 
ils n'ont aucune influence sur l'ordonnancement du dessin et sont là (excepté pour quelques fonctions particulières) uniquement 
pour faciliter la vue d'ensemble du modéliseur. Au moment du rendu, Blender ne rend que les calques sélectionnés. Si toutes 
vos Lumières sont dans un calque qui n'est pas sélectionné, vous ne verrez rien dans votre rendu sauf les Objets éclairés par la 
lumière Ambiante. 
 

Rendre visibles des Calques (Viewing layers) 
Blender offre 20 calques. Vous pouvez choisir ceux qui doivent être affichés avec les petits boutons sans référence visibles 
dans l'en-tête (image ci-dessous). Pour sélectionner un seul calque, cliquez sur le bouton approprié avec LMB ; pour en 
sélectionner plus d'un, maintenir SHIFT  tout en cliquant avec LMB .  
 

 
 

Pour sélectionner des calques par l'intermédiaire du clavier, servez-vous des touches 1 à 0 (sur la partie haute du clavier 
principal) pour les calques de 1 à 10 (la rangée supérieure des boutons), et ALT 1  à ALT 0  pour les calques de 11 à 20 (la 
rangée inférieure). Pour une sélection multiple de calques, maintenez la touche SHIFT  enfoncée en utilisant les raccourcis 
précédents. 
  
Par défaut, le bouton Cadenas (Lock) juste à droite des boutons de calques est activé; cela signifie que les modifications 
apportées aux calques visibles affectent l'ensemble des Vues 3D. Si vous choisissez de n'afficher que certains calques dans une 
Vue 3D, désélectionnez le bouton Cadenas au préalable. 
  
Déplacer des Objets entre Calques (Moving objects between layers) 
En mode Object, pour déplacer des Objets sélectionnés vers un autre calque, pressez M  (ou 
utilisez le menu Object >Move to Layer...), sélectionnez le calque de destination dans le menu 
flottant qui apparaît et validez ensuite avec le bouton OK . 

 

Les Objets peuvent être dans plus qu'un seul calque en même temps : pour sélectionner plusieurs Calques en une fois, 
maintenez SHIFT  enfoncé avant de cliquer.  
 

Une autre façon de visualiser (ou modifier) le Calque d'un Objet sélectionné est 
d'utiliser le panneau Draw. Celui-ci est accessible par F7 ou en cliquant sur 
l'icône Object (ci-contre). 

 

 

Vous verrez alors les boutons des calques (Layers) dans le panneau Draw qui 
peuvent alors être utilisés comme indiqué précédemment.  
 

Exemple d'agencement de calques 
Il vous est suggéré d'utiliser la rangée supérieure de calques pour les choses 
réellement importante, et la rangée inférieure pour celles que vous n'utilisez pas 
(ou ne modifiez pas) souvent.  

 
Dans une Scène qui fait intervenir principalement deux acteurs, vous pourriez avoir pour les Calques :  

1. Acteur  principal 
2. Acteur secondaire  
3. Acteurs de l'Arrière-plan  
4. Vêtements des Acteurs 
5. 
6. Étape principale  
7. Arrière-plan et Panneau Principaux  
8. Accessoires principaux (tables, chaises)  
9. Petits accessoires, décorations, obstacles  
10. Caméras, Lumières  

11. Armature de l'Acteur principal  
12. Armature de l'Acteur secondaire  
13: Armatures des Acteurs de l'Arrière-plan  
14. Vêtements alternatifs  
15. D'autres Maillages utilisables  
16. Différents réglages d'étapes, dimensions  
17. Différents Arrière-plans utilisables  
18. D'autres Accessoires principaux utilisables  
19. D'autres petits Accessoires 
20. Des Lumières supplémentaires  

Le Script Layer Manager 
Ce script vous permet de donner un nom aux calques. 
 

2.1.1.8. Le Bouton Render (Render Button)  
Ce bouton fournit une copie OpenGL de la Vue 3D. C'est à peu près ce que vous voyez déjà, moins la grille, les axes, etc.; elle 
ne montre que les Objets. Elle utilise le même mode d'affichage que la Vue 3D, donc elle est assez utile pour visualiser le 
Wireframe de l'Objet sur lequel vous travaillez. SHIFT cliquer sur le bouton rend une animation, ce qui est très utile pour 
visualiser des prévisualisations d'une animation.  
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2.1.2. Utiliser la Vue 3D (Using the 3D Window) 
La Vue 3D est comme une fenêtre ouverte sur le monde 3D. Pour vous aider à toujours savoir qu'elle est la direction vers le 
haut (Z), un indicateur du repère XYZ  est présent dans le coin inférieur gauche, avec le nombre d'Objets actuellement 
sélectionnés et le nom de l'Objet actif. Le reste de la Vue 3D, s'il s'agit de l'une des vues Orthogonal normales (Front , Side ou 
Top) affichera une grille. Chaque ligne de la grille est une unité Blender. L'unité Blender est une unité de mesure arbitraire.  
Dans l'espace 3D, l'Objet actif est mis en évidence en rose. Votre curseur est un cercle blanc avec une croix de visée. LMB  
déplace le curseur. Utilisez le menu Rotation pour déplacer le curseur selon d'autres méthodes.  
RMB sélectionne l'Objet qui est pointé. Sauf s'il est déjà sélectionné, auquel cas RMB le désélectionne. SHIFT RMB  
sélectionne un autre Objet en conservant sélectionnés les Objets qui le sont déjà (rappelez-vous que le dernier sélectionné est 
l'Objet actif).  
 

2.1.2.1. Le Mode Edit (Editing Mode) 
Vous passez en mode Edit  avec le menu des Modes, ou avec TAB . Dans ce mode, vous pouvez sélectionner les composants 
d'un Objet, et exécuter des commandes sur eux. Certains Objets, comme les Caméras, ne peuvent pas être édités. Pressez de 
nouveau TAB  pour revenir au mode dont vous venez.  
 

2.1.2.2. Rotation de la Vue (Rotating the View) 
Blender fournit trois points de vue par défaut : Side (vue de côté), 
Front  (vue de face) et Top (vue de dessus). Comme Blender utilise un 
système cartésien de coordonnées "main-droite", avec l'axe des Z 
pointant vers le haut, la vue Side revient à regarder dans la direction que 
suit l'axe des X dans la direction négative ; la vue Front  revient à 
regarder dans la direction que suit l'axe des Y; la vue Top suit l'axe des 
Z.  
 

Vous pouvez choisir le point de vue pour une Vue 3D (quel que soit le 
mode) avec les commandes du menu View (image ci-contre) ou en 
utilisant les raccourcis NUMPAD3 pour la vue Side, NUMPAD1 pour 
la vue Front  et NUMPAD7 pour la vue Top. Le sous-menu 
View>View Navigation contient aussi ces fonctions. 
 

Conseil Pratique : Souvenez-vous que la plupart des raccourcis 
affectent la fenêtre active, donc vérifiez que le pointeur de la 
souris est sur la fenêtre dans laquelle vous voulez agir avant 
d'utiliser ces raccourcis clavier !  

  
 

Séparément depuis ces trois directions par défaut, la vue peut être pivotée selon l'angle quelconque que vous désirez. Cliquez et 
draguez MMB sur la zone de la Vue 3D : si vous commencez à partir du centre de la fenêtre en vous déplaçant vers le haut/bas 
ou vers la gauche/droite, la vue tourne autour du centre de la fenêtre. 
 

Si vous commencez sur le bord et que vous ne déplacez pas la souris vers le centre, vous pouvez tourner autour de votre axe de 
vue. Entraînez-vous avec cette fonction jusqu’à en obtenir une bonne maîtrise. Pour changer l’angle de vision par pas de faible 
amplitude, utilisez NUMPAD8 et NUMPAD2 (qui correspondent au dragging vertical avec MMB ), ou NUMPAD4 et 
NUMPAD6 (qui correspondent à un dragging horizontal avec MMB ). 
 

Les styles TrackBall et Turntable 
Par défaut, quand vous faites pivoter la vue comme décrit dans le paragraphe précédent, vous faites pivoter la Scène comme si 
vous faisiez rouler votre main sur une Trackball . Pour certains utilisateurs, ceci est intuitif, mais pour d'autres cela ne l'est pas. 
Si vous rencontrez des difficultés avec ce style de rotation de la Vue 3D, vous pouvez passer au style Turntable .  
 

Le style Turntable  correspond davantage à un tourne-disque où vous avez deux axes de rotation disponibles et le monde 
semble posséder une meilleur définition de ce qu'est le Haut et le Bas. Le mauvais côté de l'utilisation du style Turntable  est 
que vous perdez un peu de souplesse quand vous travaillez avec vos Objets. Toutefois, vous y gagner le sens du Haut et du 
Bas qui peut vous aider si vous vous sentez désorienté. Bien sûr, vous pouvez toujours basculer entre ces styles en fonction de 
votre travail.  
 

Pour modifier le style de rotation, utilisez la fenêtre Info . Cliquez sur le bouton View & Control  
pour faire apparaître la page de boutons relatifs aux fonctions de Visualisation et de Contrôle. 
Vous verrez une zone View rotation:  permettant de choisir votre style (image ci-contre).   
Il y a deux autres boutons pour activer d'une part le passage automatique de la Vue 3D en mode Perspective et d'autre part, le 
pivotement de l'affichage autour de l'Object sélectionné. 
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2.1.2.3. Déplacement et Zoom de la Vue 
 

Déplacer la Vue (Panoramique ou Pan) 
Quel que soit le mode, pour déplacer la vue maintenez SHIFT  appuyé et draguez avec MMB  dans la Vue 3D. Pour des pas de 
faible amplitude, utilisez les raccourcis CTRL NUMPAD8 , CTRL NUMPAD2 , CTRL NUMPAD4  et CTRL NUMPAD6  
comme pour la rotation. Le sous-menu View>View Navigation contient aussi ces fonctions. 

 

Zoomer la Vue 
Quel que soit le mode, vous pouvez zoomer (+) et dézoomer (-) en maintenant CTRL  appuyé et draguant avec MMB . Les 
raccourcis sont NUMPAD+  et NUMPAD- . Le sous-menu View>View Navigation contient aussi ces fonctions.  
 

Conseil Pratique : Si votre souris possède une roulette, vous pouvez exécuter toutes les actions normalement accomplies avec 
NUMPAD+  et NUMPAD-  en tournant la molette (MW ). Le sens de rotation détermine l'action.  

 

Conseil Pratique : Si vous vous perdez dans l'Espace 3D, ce qui n'est pas rare, deux raccourcis peuvent vous aider : HOME  
recentre la vue sur tous les Objets (commande View > Frame All). Alors que NUMPAD.  recentre la vue sur les Objets 
actuellement sélectionnés (commande View > Frame Selected).  

 

2.1.2.4. Projections Perspective ou Orthographic (Perspective and Orthographic Projection) 
Chaque Vue 3D autorise deux types différents 
de projection. Ceux-ci sont illustrés dans 
l'image ci-contre : 
 

Notre œil est habitué à la vue en Perspective 
car les Objets éloignés paraissent plus petits. 
La projection Orthographic semble souvent 
moins réaliste au début, car les Objets restent 
de la même taille indépendamment de leur 
distance; c'est comme regarder la Scène depuis 
un point éloigné à l'infini. 

 
Projection Orthographic  (à gauche) et Perspective (à droite) 

 

  
Vue Orthographic  Vue Perspective 

 

Néanmoins, la vision Orthographic  est très utile (c'est la vision par défaut dans Blender et dans la plupart des autres 
applications 3D), parce qu'elle fournit un aperçu plus "technique" de la Scène, facilitant ainsi le dessin et l'appréciation des 
proportions.  
 

Quel que soit le mode, pour modifier la projection dans une Vue 3D, sélectionnez View>Orthographic  ou View>Perspective 
(dans le menu View d'une Vue 3D). Le raccourci NUMPAD5 bascule entre les deux modes. 
 

Conseil Pratique : Modifier la projection dans une Vue 3D n'affecte pas la manière dont la Scène sera rendue. Le rendu est, 
par défaut, calculé en Perspective. Si vous avez besoin d'un rendu Orthographic , sélectionnez la caméra et validez le bouton 
Orthographic  dans le panneau Camera du contexte Edit  (F9).  

 

Détails Techniques 
 

Définition de la Perspective 
Une vue en Perspective est construite géométriquement de la façon suivante : vous avez une Scène en 3D et vous êtes un 
observateur placé en un point O. La Scène en Perspective 2D est construite en plaçant un plan, une feuille de papier où la 
Scène 2D doit être tracée en face du point O, perpendiculairement à la direction d'observation. Pour chaque point P dans la 
Scène 3D, une ligne est tracée, passant par O et P. Le point d'intersection S entre cette ligne et le plan est la projection en 
Perspective de ce point. En projetant tous les points P de la Scène, vous obtenez une vue en Perspective.  
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Définition de la Projection Orthographic 
Dans une projection Orthographic , également appelée "orthonormale", vous avez une direction de vue mais pas de point de 
vue O. La ligne est donc tracée par le point P de sorte qu'elle soit parallèle à la direction d'observation. Les intersections S 
entre la ligne et le plan sont la projection Orthographic . Et en projetant tout point P de la Scène vous obtenez la vue 
Orthographic . 
 

La commande Camera du menu View règle la Vue 3D en mode Camera. 
(raccourci : NUMPAD0). La Scène est alors affichée comme elle sera rendue 
ultérieurement (image ci-contre) : l'image rendue contiendra tout ce qui figure à 
l'intérieur de la ligne pointillée extérieure.  
 

Zoomer (+) ou dézoomer (-) est possible dans cette vue, mais pour modifier le point 
de vue, vous devez déplacer ou faire pivoter la caméra.  
 

 

 
2.1.2.5. La Toolbox de la Vue 3D (3D Window Toolbox) 
Pressez SPACE dans la Vue 3D fait apparaître un menu très pratique qui est, en partie, une version réduite des menus de 
l'entête.  
 

Le menu Add 
Ce menu vous permet d'ajouter des Objets à votre Scène.  
• Mesh : Ce sous-menu vous permet d'ajouter des Maillages polygonaux à votre Scène. Le Monkey (Suzanne) est très utile 

pour effectuer des tests (pour essayer de nouveaux Matériaux, une fourrure, etc.)  
• Curve : Ce sous-menu vous permet d'ajouter des courbes (Curve) ou des chemins (Paths) à votre Scène. Ceux-ci sont 

utiles pour modéliser des Objets courbés ou pour créer un cheminement à suivre par des Objets animés.  
• Surface : Ce sous-menu vous permet d'ajouter des Objets NURBS à votre Scène.  
• Meta : Ce sous-menu vous permet d'ajouter des Objets Meta à votre Scène. Ce sont des Objets générés par algorithme et 

ils sont très utiles pour des effets spéciaux.  
• Text : Cette commande vous permet d'ajouter des Objets Text à votre Scène.  
• Empty : Cette commande vous permet d'ajouter des Objets Empty à votre Scène. Les Objets Empty ne sont pas rendus; 

ils sont généralement utilisés pour contrôler l'aspect d'autres Objets. Par exemple, vous pouvez utiliser un Empty pour 
contrôler la rotation d'un Modificateur Array . Comme ils ne sont pas rendus, vous pouvez utiliser ces Objets pour toutes 
sortes de choses (telles que des Hooks, etc.) qui nécessitent qu'un Objet obtienne d'eux une position, une rotation et/ou une 
taille.  

• Group : Ce sous-menu vous permet d'ajouter des copies de tous les Groupes que vous avez dans votre Scène. Ceci est très 
utile si vous avez des Objets entiers groupés ensembles, car vous pouvez aisément ajouter des copies de ces groupes.  

• Camera : Cette commande vous permet d'ajouter une Caméra à votre Scène.  
• Lamp : Ce sous-menu vous permet d'ajouter diverses Lumières à votre Scène. Pour plus d'informations, voyez le 

paragraphe VI – LES TECHNIQUES D'ILLUMINATION (Lighting) .  
• Armature  : Cette commande vous permet d'ajouter un Objet Armature  (squelette) à votre Scène. Ces Objets sont 

principalement utilisés pour animer des bras, des jambes, etc. mais vous pouvez aussi animer un simple lampe!  
• Lattice : Cette commande vous permet d'ajouter un Objet Lattice à votre Scène. Ces Objets ne font rien eux-mêmes; 

toutefois, vous pouvez les utiliser pour déformer d'autres Objets. Pour cela, vous devez ajouter un Modificateur Lattice à 
l'Objet que vous voulez déformer. Vous pouvez alors placer le Lattice autour de l'Objet (comme une cage), et toute 
modification au Lattice déformera l'Objet. Plus l'objet que vous déformez sera détaillé, et meilleur sera son aspect, donc un 
Modificateur Subsurf peut être utile ici.  

 

Le menu Edit 
• Enter Editmode : Cette commande vous fait passer en mode Edit , qui vous permet d'éditer les vertices, arêtes et faces 

d'un Objet spécifique, plutôt que de manipuler l'Objet entier.  
• Duplicate : Cette commande crée un duplicata séparé des Objets sélectionnés.  
• Duplicate Linked : Cette commande crée un duplicata de l'Objets sélectionné; toutefois les données de cet Objet 

(ObData) sont partagées avec d'autres Objets.  
• Delete : Cette commande efface les Objets sélectionnés.  
• Object Keys : Ce sous-menu contient des commandes qui concernent les images-clés (keyframes).  

o Show/Hide : Cette commande fait apparaître/disparaître la version Wireframe des images-clés de l'Objet sélectionné. 
Ceci est utile pour vous permettre de visualiser le chemin de l'Objet sélectionné.  

o Select Next : Cette commande sélectionne la prochaine image-clé pour l'Objet sélectionné.  
o Select Prev : Cette commande sélectionne l'image-clé précédente pour l'Objet sélectionné.  

 

Le menu Select 
Ce menu est identique au menu Select trouvé dans l'entête (voir plus haut). 
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Le menu Transform 
Ce menu regroupe une partie du menu Object trouvé dans l'entête (voir plus haut). 
 

Le menu Object 
Ce menu regroupe l'autre partie du menu Object trouvé dans l'entête (voir plus haut). 
 

Le menu View 
Ce menu est en grande partie identique au menu View trouvé dans l'entête (voir plus haut). 
 

Le menu Render 
• Passepartout : Cette commande active/désactive l'option Passepartout de la Caméra sélectionnée. Quand cette option est 

activée, elle assombrit la zone autour de la Caméra, en vous permettant de vous focaliser sur la zone qui sera réellement 
rendue.  

• Set Border : Cette commande vous permet de draguer pour sélectionner une zone spécifique de la vue Caméra pour être 
rendue. Ceci est utile si vous voulez étudier un détail spécifique de l'Objet sans rendre la Scène entière. 

• Render (F12) : Cette commande permet de rendre la Scène courante.  
• Anim  (CTRL F12): Cette commande permet de rendre l'animation en cours.  
• Preview : Cette commande permet de faire apparaître le panneau Preview Render qui affiche une prévisualisation (non 

antialiasée) de la partie de la Vue 3D qui se trouve immédiatement sous le panneau.  
 

2.1.3. La Vue Camera (Camera View) 
 

Ajouter une nouvelle Caméra (Add a new camera) 
En mode Object, pressez SPACE et dans le menu flottant, sélectionnez 
Add>Camera (ou utilisez  SHIFT A ). 
 

Les nouvelles Caméras sont directement parallèles à la Vue 3D courante. 
 

Utilisez F9 pour modifier les réglages de la Cam&ra. 

 
 

Modifier la Caméra active (Change active camera) 
La Caméra active est la caméra qui est effectivement utilisée pour le rendu. Pour être rendue, 
chaque Scène doit posséder une Caméra. 
En mode Object, sélectionnez la caméra que vous voulez rendre active et pressez CTRL 
NUMPAD0.  
La Caméra active dans la Vue 3D est celle qui possède un triangle rempli sur son sommet 
(celle de gauche sur l'image ci-contre). 
 

 
 

Déplacer la Caméra active dans la Vue 3D (Move active camera to view) 
En mode Object, sélectionnez une Caméra, puis allez à la position et direction désirées pour votre caméra dans la Vue 3D. 
Maintenant, pressez ALT CTRL NUMPAD0  et votre Caméra sélectionnée se positionne elle-même à votre emplacement et 
passe en vue Caméra.  
 

Les Réglages de la Caméra (Camera Settings) 
Les Caméras sont invisibles dans une Scène; elles ne sont jamais rendues, donc elles n'ont pas de réglages de Matériaux ou de 
Textures. Toutefois, elles disposent d'un panneau Camera en mode Object et Edit . 
 

• Lens : Ce bouton numérique indique la focale de la lentille de la Caméra en mm. 
Si le bouton Orthographic est activé, ce bouton devient un bouton numérique 
Scale. 35mm est un réglage standard. 

• DoFDist : Ce bouton numérique permet de régler la distance du point focal 
(profondeur de champ). Elle apparaît sous forme d'une croix jaune dans la ligne 
de visée de la Caméra. Le bouton Limits  doit être activé pour voir cette croix. 

• Orthographic  : Ce bouton permet d'activer/désactiver le mode Orthographic 
pour le rendu. Pour plus d'informations, voyez le paragraphe 2.1.1.4. Projections 
Perspective ou Orthographic (Perspective and Orthographic Projection).  

 

• Clipping: (Start: , End:) : Ces deux boutons numériques permettent de régler les limites 
inférieur et supérieure de la zone de découpe (clipping). Tous les Objets situés entre ces 
limites sont rendus. Si le bouton Limits  est activé, la zone de découpe sera visualisée par 
deux points jaunes sur la ligne de visée de la Caméra (un à l'origine de la Caméra et 
l'autre en  C sur l'image ci-contre). Dans de grandes Scènes, End: doit être réglé élevé où 
les choses 'disparaissent' de la vue.  

• Shift:  (X: , Y: ) : Ces boutons numériques permettent de décaler la vue Caméra (voir le 
conseil pratique plus loin).  
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• Limits : Ce bouton permet d'activer/désactiver l'indication des limites.  
• Mist  : Ce bouton permet d'activer/désactiver la visualisation des limites du brouillard 

(mist). Ces limites sont visualisées par deux points blancs sur la ligne de visée de la 
caméra. Les points A et B sur l'image ci-dessus. Le brouillard est réglé dans le panneau 
World  (F8).  

• Name : Ce bouton permet d'activer/désactiver l'affichage du nom de la Caméra.  D sur 
l'image ci-contre.   

La vue Caméra 
• Title Safe : Ce bouton permet d'activer/désactiver l'affichage d'un cadre de tirets supplémentaire dans la vue Caméra (E 

dans l'image ci-contre) pour aider au placement des Objets.  
• Passpartout : Ce bouton permet d'activer/désactiver l'assombrissement de la zone en-dehors de la vue Caméra. 
• Alpha : Ce curseur permet de contrôler l'assombrissement de la zone activée par le bouton Passpartout. 
• Size : Ce bouton numérique permet de régler la taille de l'Objet Camera dans la Vue 3D. 
 

Conseil Pratique : avec l’option Shift: , il est possible de modifier le 
cadrage de la Caméra selon les axes X et Y. Et ceci, sans modifier la 
position de la Caméra! Vous pouvez ainsi déterminer un bon point de vue 
pour vos modèles, sans vous occuper du cadrage de la Caméra pour le 
Rendu. Il s’agit simplement de positionner et faire pivoter la Caméra pour 
trouver un bon point de vue, et quand vous l’avez trouvé, vous ajustez le 
cadrage avec l’option Shift. Voyez l’exemple ci-contre : un bon point de 
vue a été trouvé pour le modèle; le point de fuite est exactement comme 
voulu, mais le modèle est en dehors du cadrage !  
 

Maintenant, vous allez modifier les valeurs de l’option Shift: , pour 
modifier le cadrage de la Caméra (image ci-contre). Le modèle sera 
maintenant visible là où vous le vouliez dans votre rendu final! De cette 
façon, vous conservez la Caméra à sa place et vous obtenez le point de 
vue voulu.  

 
 

   
Navigation avec la Caméra (Camera Navigation) 
Pour contrôler la Caméra, tout en visualisant à travers elle (NUMPAD0), vous pouvez : 
• Pointer la Caméra (Aiming the Camera) : Pressez SHIFT F  pour passer en mode Fly, puis déplacez la souris pour 

pointer la Caméra, LMB  pour activer la nouvelle orientation, RMB  (or ESC) pour abandonner. 
• Roulis (Rolling) : Pour donner un mouvement de roulis à la Caméra, celle-ci doit être sélectionnée (tout en regardant à 

travers, RMB  sur les arêtes du rectangle solide la sélectionne), puis pressez R pour passer dans le mode de rotation 
standard pour un Objet, l'action par défaut sera de faire pivoter la caméra autour de son axe Z local. 

• Tangage (Pitch) : Pour pivoter autour de l'axe X local de la Caméra, pressez R, puis XX . Le premier X (ou Y, ou Z) 
sélectionne l'axe Global, et presser la 'lettre de l'axe' une seconde fois, sélectionne l'axe Local (ceci fonctionne pour la 
rotation de n'importe quel Objet). 

• Dolly : Pour faire un Dolly de la Caméra, pressez G puis MMB , LMB  pour terminer. 
• Tracking de Caméra (Track Camera) : Pressez G (Grab) et déplacez la souris (LMB  pour fixer la position). 
 


